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Environmental and Safety Consideration

 

Laser Safety Statement

 

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, 
chapter 1 Subchapter J for Class I(1) laser products, and elsewhere, is certified as a 
Class I laser product conforming to the requirements of IEC 825.

Class I laser products are not considered to be hazardous. The laser system and 
printer are designed so there is never any human access to laser radiation above a 
Class I level during normal operation, user maintenance, or prescribed service 
condition.

 

WARNING

 

  
Never operate or service the printer with the protective cover removed from Laser/
Scanner assembly. The reflected beam, although invisible, can damage your eyes.
When using this product, these basic safety precautions should always be followed to 
reduce risk of fire, electric shock, and injury to persons:
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Ozone Safety

 

During normal operation, this machine produces ozone. The 
ozone produced does not present a hazard to the operator. 
However, it is advisable that the machine be operated in a well 
ventilated area.

If you need additional information about ozone, please contact 
your nearest Samsung dealer.

 

Power Saver

 

This printer contains advanced energy conservation 
technology that reduces power consumption when it is not 
in active use.

When the printer does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

The energy star emblem does not represent EPA 
endorsement of any product or service.

 

Radio Frequency Emissions

 

FCC regulations

 

This device has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

 

1

 

Reorient or relocate the receiving antenna.

 

2

 

Increase the separation between the equipment and receiver.

 

3

 

Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

 

4

 

Consult the dealer or an experienced radio/TV technician for help.

 

CAUTION:

 

 Changes or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user’s authority to operate the equipment.
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Canadian Radio Interference Regulations

 

This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus as set out in the interference-causing equipment standard 
entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux 
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: 
“Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

 

Declaration of Conformity (European Countries)

 

Approvals and Certifications

 

The CE marking applied to this product symbolizes Samsung 
Electronics Co., Ltd. Declaration of Conformity with the following 
applicable 93/68/EEC Directives of the European Union as of the 
dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the 
member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of the 
laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity.

A full declaration, defining the relevant Directives and referenced standards can be 
obtained from your Samsung Electronics Co., Ltd. representative.

 

EC Certification

Certification to 1999/5/EC Radio Equipment & 
Telecommunications Terminal Equipment Directive (FAX)

 

This Samsung product has been self-certified by Samsung for pan-European single 
terminal connection to the analogue public switched telephone network (PSTN) in 
accordance with Directive 1999/5/EC. The product has been designed to work with 
the national PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics 
Co., Ltd. in the first instance.

The product has been tested against TBR21 and/or TBR 38. To assist in the use and 
application of terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 
201 121) which contains notes and additional requirements to ensure network 
compatibility of TBR21 terminals. The product has been designed against, and is fully 
compliant with, all of the relevant advisory notes contained in this document.
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NTRODUCTION

 

Congratulations on the purchase of your Printer! 

This chapter includes:

 

• Special Features

• Printer Components

• Understanding the Control Panel
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1.
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Special Features

 

Your new printer is equipped with special features that improve 
the print quality, giving you a competitive edge. You can:

 

Print with excellent quality and high speed

 

• You can print at 

 

1200 dots per inch

 

 (dpi). See page 4.16.

• Prints 

 

17 pages-per-minute (Letter size)

 

, 

 

16 pages-per-minute (A4 size)

 

.

 

Handle paper flexibly

 

• 

 

Standard 250-sheet tray

 

 and a 1-sheet Manual Feeder 
support various sizes and types of paper.

• Two output tray; select either 

 

the top output tray (face-
down)

 

 or 

 

the rear output tray (face-up)

 

 for the most 
convenient access.

 

Create professional documents

 

• You can customize your documents using 

 

Watermarks

 

, such 
as “Confidential.” See page 4.19.

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the selected sheet 
of paper. After the document has printed, trim off the white 
edges of each sheet. Tape the sheets together to form a 
poster. See page 4.14.

Save your time and money 

• Allows you to use the Toner Save mode to save toner. See 
page 4.8.

• Allows you to print multiple pages on one single sheet of paper 
to save paper (N-Up printing). See page 4.10.

• This printer meets Energy Star guidelines for energy 
efficiency.

WORLD BEST

Dear ABC

Regards
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Print in various environments

• You can print in Windows 95/98/Me/NT 4.0/2000/XP.

• Your printer is compatible with Linux and Macintosh. 

• Your printer comes with both the Parallel and the USB 
interface.
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Printer Components

Front View

Manual Feeder 
guide Tray

Front
Cover

Top output 
tray (Face 
down) Control Panel

Power switch

Paper level indicatorManual Feeder

Output Support
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Inside View

Rear View

Front Cover

Toner
cartridge

Rear output tray
(Face up)

Power 
receptacle

Parallel 
port

USB 
port
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Understanding the Control Panel

On Line/Error and Toner Save LEDs

LED Description

If the On Line/Error lights green, the printer is ready to 
print. 

If the On Line/Error lights red, the printer is experiencing 
an error, such as jammed paper, the open cover or the empty 
toner cartridge. See “Troubleshooting Error Messages” on 
page 6.17. 

If you press the Cancel button while the printer is receiving 
data, the On Line/Error LED blinks red to cancel printing.

In Manual Feed mode, if there is no paper in the Manual 
Feeder, the On Line/Error LED blinks red. Load paper into 
the Manual Feeder and the LED stops blinking. 

If the printer is receiving data, the On Line/Error LED 
slowly blinks green. 
If the printer is printing the received data, the On Line/
Error LED blinks green fast. 

If you press the Cancel button in Ready mode, this LED is on 
and the Toner Save mode is enabled. 
If you press this button once again, this LED is off and the 
Toner Save mode is disabled. 
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Cancel button

If the On Line/Error and Toner save LEDs blink, your 
system has some problems. To solve the problem, see 
“Troubleshooting Error Messages” on page 6.17

LED Description

Function Description

Printing demo page In Ready mode, press and hold this button for about 2 
seconds until all LEDs blink slowly, and release. 

Printing 
configuration sheet

In Ready mode, press and hold this button for about 6 
seconds until all LEDs blink fast, and release. 

Manual feeding Press this button each time you load a sheet of paper in the 
manual feeder, when you select Manual Feed for Source 
from your software application. For detailed information, 
see “Using the Manual Feeder” on page 3.8. 

Cleaning inside 
printer

In Ready mode, press and hold this button for about 10 
seconds until all LEDs turn on, and release. After cleaning 
the printer, one cleaning sheet prints.

Canceling print job Press this button during printing. The On Line/Error LED 
blinks while the print job is cleared from both the printer 
and the computer, and then return to Ready mode. This 
may take some time depending on the size of the print job. 

In Manual Feed mode, you can’t cancel the print job by 
pressing this button. For detailed information, see “Using 
the Manual Feeder” on page 3.8. 

Toner Save mode 
on/off

In Ready mode, press this button to turn the Toner Save 
mode on or off. 
For detailed information, see page 4.8. 
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NOTE
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This chapter provides step by step information on setting up 
your printer. 

This chapter includes:

• Unpacking

• Installing the Toner Cartridge

• Loading Paper

• Connecting a Printer Cable

• Turning the Printer on

• Printing a Demo Page

• Installing Printer Software

SETTING UP YOUR PRINTER
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Unpacking

1 Remove the Printer and all accessories from the packing 
carton. Make sure that the printer has been packed with the 
following items:

Notes:

• If any items are missing or damaged, notify your dealer 
immediately. 

• Components may differ from one country to another.
• The CD-ROM contains the printer driver, the User’s Guide, and 

the Adobe Acrobat Reader program. 

2  Carefully remove all of packing tapes from the printer. 

Toner Cartridge Power Cord

CD-ROM Setup Guide

Tape
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Selecting a Location

Select a level, stable place with adequate space for air 
circulation. Allow extra space for opening covers and tray. The 
area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. See the image below for 
clearance space. Do not set the printer close to the edge of your 
desk or table!

Clearance
Space

•Front: 482.6 mm (enough space so that tray can be 
removed)

•Back: 100 mm (enough space to allow opening of the rear 
out tray)

•Right: 100 mm (enough space for ventilation)
•Left: 100 mm

552 mm(21.7 in.)

1
0
0
 m

m

(3
.9

 i
n
.)

9
5
4
.6

 m
m

(3
7
.5

 i
n
.)

4
8
2
.6

 m
m

(1
8
.8

 i
n
.)

100 mm

(3.9 in.)

100 mm

(3.9 in.)
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Installing the Toner Cartridge

1 Grasp the front cover and pull it toward you to open.

Note: Because the printer is very light, it may be moved when you 
use it; for example, when opening/closing the tray or installing/
removing the toner cartridge or installing. Be careful not to move 
the printer.

2 Remove the toner cartridge from its bag and remove the 
paper covering the cartridge. Discard it.

3 Gently shake the cartridge from side to side to distribute 
the toner evenly inside the cartridge.

CAUTION:

• To prevent damage, do not expose the toner cartridge to light for 
more than a few minutes. Cover it with a piece of paper, if left 
exposed for more than a few minutes.

• If toner gets on your clothing, wipe it off with a dry cloth and 
wash clothing in cold water. Hot water sets toner into fabric.
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4 Locate the cartridge slots inside the printer, one on each 
side.

5 Grasp the handle and insert the cartridge in the printer until 
it snaps into place.

6 Close the front cover. Make sure that the cover is securely 
closed.

Note: When printing text at 5% coverage, you can expect a toner 
cartridge life of approximately 3,000 pages (1,000 pages for the 
toner cartridge that is shipped with the printer).
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Loading Paper

You can load approximately 250 sheets of paper in the tray.

1 Pull the tray out of the printer.

Note: Because the printer is very light, it may be moved when you 
use it; for example, when opening/closing the tray or installing/
removing the toner cartridge or installing. Be careful not to move 
the printer.

2 Push down on the pressure plate until it locks in position.

3 Prepare a stack of paper for loading by flexing or fanning 
them back and forth. Straighten the edges on a level 
surface.
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4 Load paper with the print side facing down. 

Make sure that all four corners are flat in the tray. 

5 Pay attention to the paper limit mark on the left inside wall 
of the tray. Paper overloading may cause paper jams.

Note: If you want to change the paper size in the tray, see 
““Changing the Paper Size in the Tray” on page 2.8” . 

6 Slide the tray back into the printer.
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Changing the Paper Size in the Tray

1 Pinch the rear guide as shown below to adjust for the paper 
length. 

2 Pinch the side guide as shown and slide it to the left flush 
against the paper. 

Notes: 

• Do not push the width guide far enough to cause the material to 
warp. 

• If you do not adjust the width guide, it may cause paper jam.
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Connecting a Printer Cable

To print from your computer, you need to connect your printer 
to your computer with either a parallel interface cable or a 
Universal Serial Bus (USB) cable. 

If you are a Macintosh user, you can use only a USB cable. 

Using a Parallel Cable

Note: To connect the printer to the parallel port of the computer 
requires a certified parallel cable. You will need to buy a IEEE1284 
compliant cable.

1 Make sure that both the printer and the computer are 
turned off.

2 Plug the parallel printer cable into the connector on the 
back of the printer. 

Push the metal clips down to fit inside the notches on the 
cable plug.

3 Connect the other end of the cable to the parallel interface 
port on your computer, and tighten the screws. 

See your computer User’s Guide if you need help.

To the parallel port on 
your computer
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Using a USB Cable

Note: Connecting the printer to the USB port of the computer 
requires a certified USB cable. You will need to buy a USB 2.0 
compliant cable that is within 3m in length. 

1 Make sure that both the printer and the computer are 
turned off.

2 Plug the USB printer cable into the connector on the back of 
the printer.

3 Connect the other end of the cable to the USB port on your 
computer. 

See your computer User’s Guide if you need help. 

Note: 

• For using a USB cable, you must be running Windows 98/Me/
2000/XP, or Macintosh with OS 8.6 and the G3 processor or 
higher. 

• In Windows 98/Me, if you want to print using the USB interface, 
you must install the USB driver to add the USB port. See 
page 2.18.

• In Windows 2000/XP, if you want to print using the USB 
interface, you must install the Printer driver. See page 2.15. 

To the USB port on 
your computer
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Turning the Printer on

1 Plug the power cord into the power receptacle on the back 
of the printer. 

2 Plug the other end into a properly grounded AC outlet and 
turn on the printer using the power switch. 

To the AC outlet
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Printing a Demo Page

Print a demo page or a configuration sheet to make sure that the 
printer is operating correctly.

1 Hold down the Cancel button for about 2 seconds to print a 
demo page. 

OR

Hold down the Cancel button for about 6 seconds to print a 
configuration sheet.

2 The Demo page or the configuration sheet shows the 
printer’s current configuration. 

Laser Beam Printer

ML-2150Series 

Excellent Performance, High quality

Robust Network connectivity

Compatibility

Samsung ML-1750 Series 

Demo page Configuration sheet
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Installing Printer Software

The supplied CD-ROM contains Windows printing software, 
Macintosh printing software, Linux printing software, on-line 
User’s Guide and Acrobat Reader to view the User’s Guide. 

If you are printing from Windows

You can install the following printer software using the CD-ROM. 

• SPL printer driver for windows. Use this driver to take full 
advantage of your printer’s features. See page 2.15.

• Status Monitor allows you to see the printing status of the 
printer. See page 4.26.

• Remote Control Panel for DOS application. Go to “Printing 
from DOS Applications” on page 7.20, for information about 
installing the Remote Control Panel and printing from DOS 
applications. 

• USB driver for adding the USB port to Windows 98/Me. You 
must first install the USB driver for the USB connection in 
Windows 98/Me. In Windows 2000/XP, the USB port is 
provided, so that you don’t have to install the USB driver. Just 
install the printer software; see page 2.15. 

If you are printing from Macintosh

Go to “Using Your Printer with a Macintosh” on page 7.2, for 
information about installing the print software and printing from 
a Macintosh.

If you are printing in Linux

Go to “Using Your Printer in Linux” on page 7.10, for information 
about installing the Linux driver.
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Printer Driver Features

The your printer drivers will support the following standard 
features:

• Paper source selection

• Paper size, orientation and media type

• number of copies

Table below lists a general overview of features supported by the 
your printer drivers. 

Feature
SPL

Win9x/Me Win2000/XP NT4.0 Macintosh

Toner Save Y Y Y N

Print quality option Y Y Y Y

Poster printing Y Y Y N

Multiple pages per sheet 
(N-up) Y Y Y Y

Fit to page printing Y Y Y N

Scale printing Y Y Y Y

Watermark Y Y Y Y

Overlay Y Y Y N
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Installing Printer software in Windows

System Requirements

Verify the following:

• At least 32 MB (Windows 9x/Me), 64 MB (Windows 2000/NT), 
128 MB (Windows XP) or more of RAM is installed on your PC. 

• There is at least 200 MB (Windows 9x/Me), 650 MB (Windows 
2000/NT), 1.5 GB (Windows XP) of free disk space on your PC.

• All applications are closed on your PC before beginning 
installation. 

• Windows 95, Windows 98, Windows Me, Windows NT 4.0, 
Windows 2000 or Windows XP.

Installing Printer Software

1 Place the CD-ROM in the CD-ROM drive. Installation will 
start automatically.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type 
x:\cdsetup.exe in the Open box (where x is the drive 
letter for the CD-ROM drive), then click OK.

Note: If the New Hardware Found window appears during the 
installation procedure, click  in the upper right coner of the box, 
or click Cancel. 

2 When the language selection window appears, select the 
appropriate language. 

If you can’t find the desired language from the screen, 
scroll through the screen using the scroll button on the 
bottom right of the screen.
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3 Click Install the Samsung Software I on your PC (SPL 
Driver) or Install the Samsung Software II on your PC 
(Status Monitor). 

4 The Welcome window opens. Click Next.

5 Follow the instructions on the window to complete the 
installation. 

Reinstalling Printer software

Reinstall is required if your installation fails.

1 From the Start menu, select Programs.

2 Select Samsung ML-2150 Series, and then Samsung 
ML-2150 Series Driver Maintenence.

3 The Samsung ML-2150 Series Driver Maintenance window 
appears. Click Repair and then click Next. 

4 When reinstallation is done, click Finish. 
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Removing Printer software

1 From the Start menu, select Programs.

2 Select Samsung ML-2150 Series, and then Samsung 
ML-2150 Series Driver Maintenence. 

3 The Samsung ML-2150 Series Driver Maintenance window 
appears. Check Remove and then click Next. 

4 When you are asked to confirm your selection, click OK. 

The Samsung ML-1750 Series printer driver and all of its 
components are removed from your computer. 

5 When removing is completed, click Finish. 

Changing the Display Language

After installation of the software, you can change the display 
language. If you installed the Remote Control Panel or the 
Status Monitor, the selected language is applied to them. 

1 From the Start menu, select Programs.

2 Select Samsung ML-2150 Series, and Language 
Selection.

3 Select the desired language from the language selection 
window, and click OK. 
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Installing the USB Driver in 
Windows 98/Me

1 Connect the printer to your computer using the USB cable 
and turn them on. For detailed information, see page 2.10. 

2 The Add New Hardware Wizard window appears. Click 
Next. 

3 Place the CD-ROM in the CD-ROM drive and check Search 
for the best driver for your device and click Next. 

4 Check CD-ROM drive and click Browse, and choose 
x:\USB (where x is the drive letter for the CD-ROM drive). 
Click Next. 

5 Click Next. The USB driver will be installed. 

6 When the installation is completed, click Finish. 

7 When the language selection window appears, select the 
appropriate language. 

Note: If you already installed the printer software, this screen 
doesn’t appear. 
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8 Follow the instructions on the window to complete the 
printer software installation. For more details, see 
page 2.15. 

Notes:

• If you want to use your printer with the parallel cable, remove 
the USB cable and connect the parallel cable. Then reinstall the 
printer driver. 

• If your printer doesn’t work properly, reinstall the printer driver. 
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This chapter will help you understand types of paper you 
can use with this printer and how to properly load paper in 
the tray for the best print quality. 

This chapter includes:

• Choosing Paper and Other Materials

• Selecting the Output Location

• Loading Paper

• Printing on Envelopes

• Printing on Labels

• Printing on Transparencies

• Printing on Card Stock or Custom-sized Materials

Using Print Materials
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Choosing Paper and Other Materials

You can print on a variety of print materials, such as plain paper, 
envelopes, labels, transparencies and so on. See “Paper 
Specifications” on page 7.30. To get the best possible print 
quality, use only high-quality copier-grade paper.

When you choose print materials, consider the followings:

• Desired outcome: The paper you choose should be 
appropriate for the project.

• Size: You can use any size paper that fits easily within the 
paper adjusters of the paper feeder.

• Weight: Your printer supports paper weight as follows:

      • 16~24 lbs (60~90g/m2) bond for the tray

      • 16~43 lbs (60~163 g/m2) bond for the manual feeder

• Brightness: Some papers are whiter than others and produce 
sharper, more vibrant images. 

• Surface smoothness: The smoothness of the paper affects 
how crisp the printing looks on the paper.

CAUTION: Using a material that does not conform to the 
specification listed in the paper specification can cause problems 
that may require service. This service is not covered by the 
warranty or service agreements.
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Sizes and Capacities

Size
Input Source/Capacitya

a. Depending on paper thickness, the maximum capacity may be reduced. 

Tray Manual Feeder

Plain Paper 
  Letter (8.5 x 11 in.)

  Legal (8.5 x 14 in.)

  Executive (7.25 x 10.5 in.)

  Folio (8.5 x 13 in.)

  A4 (210 x 297 mm)

  B5 (182 x 257 mm)

  A5 (148 x 210 mm)

  A6 (105 x 148 mm)

250

250

250

250

250

250

250

250

1

1

1

1

1

1

1

1

Envelopesb

  No. 10 (4.12 x 9.5 in.)
  Monarch (3.87 x 7.5 in.)
  C5 (162 x 229 mm)
  DL (110 x 220 mm)
  B5 (176 x 250 mm)
  C6 (114 x 162 mm)

b. If you are experiencing excessive jamming, feed one sheet at a time through the 
manual feeder.

-
-
-
-
-
-

1
1
1
1
1
1

Labelsb

Letter (8.5 x 11 in.)
A4 (210 x 297 mm)

-
-

1
1

Transparenciesb

Letter (8.5 x 11 in.)
A4 (210 x 297 mm)

-
-

1
1

Card stocksb - 1
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Guidelines for Paper and Special Materials

When selecting or loading paper, envelopes, or other special 
materials, keep these guidelines in mind:

• Attempting to print on damp, curled, wrinkled, or torn paper 
can cause paper jams and poor print quality.

• Use cut-sheet paper only. You cannot use multi-part paper.

• Use only high-quality, copier grade paper for the best print 
quality. 

• Do not use paper that has been already printed on or that has 
been fed through a photocopier.

• Do not use paper with irregularities, such as tabs or staples.

• Do not attempt to load any feeder during printing and never 
overfill the feeder. This could cause a paper jam.

• Avoid paper with embossed lettering, perforations, or texture 
that is too smooth or too rough.

• Colored paper should be of the same high quality as white 
photocopy paper. The pigments must withstand the printer’s 
fusing temperature of 400°F (205°C) for 0.1 second without 
deterioration. Do not use paper with a colored coating that was 
added after the paper was produced.

• Preprinted forms must be printed with nonflammable, heat-
resistant ink that do not melt, vaporize, or release hazardous 
emissions when subject to the printer’s approximately 400°F 
(205°C) fusing temperature for 0.1 second.

• Store paper in its ream wrapper until ready to use. Place 
cartons on pallets or shelves, not on the floor. 

• Do not place heavy objects on top of the paper, whether it is 
packaged or unpackaged. 

• Keep paper away from moisture, direct sunlight or other 
conditions that can cause it to wrinkle or curl.
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Selecting the Output Location

The printer has two output locations: the rear output tray and 
the top output tray. 

To use the top output tray, be sure the rear output tray is closed. 
To use the rear output tray, open it.

Notes:

• If paper coming out of the top output tray has problems, such as 
excessive curl, try printing to the rear output tray.

• To avoid paper jams, do not open or close the rear output tray 
while the printer is printing.

Printing to the Top Output Tray (Face down)

The top output tray collects paper face-down, in correct order. 
The top output tray should be used for most print jobs.

❷ Top output tray ❷ Rear output tray
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Printing to the Rear Output Tray (Face up)

The printer always prints to the rear output tray if it is open. 
Paper comes out of the printer face-up, and each time a sheet 
of paper comes out, it falls down from the printer.

Printing from the Manual Feeder to the rear output tray provides 
the straight paper path. Opening the rear output tray might 
improve the output quality with the following:

• envelopes
• labels
• transparencies

To open the rear output tray:

1 Open the rear door by pulling it down. The cover functions 
as the output tray.

Notes: Please be careful when you open the rear cover. The inside 
of the printer is still hot.
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2 If you do not want to stack the printed pages on the rear 
output tray close the tray. The pages will stack on the top 
output tray.

Loading Paper

Proper paper loading helps prevent paper jams and ensure 
trouble-free printing. Do not remove the tray while a job is 
printing. Doing so may cause a paper jam. See “Sizes and 
Capacities” on page 3.3 for acceptable paper size and capacities 
for each tray. 

The paper level bar on the front of the paper tray shows the 
amount of paper currently right in the tray. When the tray is 
empty, the indicator of the bar is lowered.

Using the Tray

The tray holds 250 sheets of paper. See “Sizes and Capacities” 
on page 3.3 for acceptable paper size and capacities of each 
tray.

Load a stack of paper into the tray and print. for details about 
loading paper in the tray, see “Loading Paper” on page 2.6. 

��Paper emptyPaper full �
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Using the Manual Feeder

If you select Manual Feed in the Source option, you can 
manually load paper in the manual feeder. Manually loading 
paper can be helpful when you want to check the print quality 
after each page is printed. 

If you experience a paper jam from the tray, load one sheet of 
paper at a time into the manual feeder. 

1 Load the print material in the manual feeder with the print 
side up. 

Adjust the paper guide against the print material without 
bending the paper.

2 When you print a document, you must select Manual Feed 
for Source from the software application, and then select 
the correct paper size and type. For details, see page 4.6. 

3 Press the Cancel button to start feeding.

4 Printing is started. 

5 If you are printing multiple pages, load the next sheet after 
the first page prints out, and press the Cancel button. 

Repeat this step for every page to be printed. 
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In Manual Feed mode, you can’t cancel a print job by pressing 
the Cancel button. 

To cancel a print job in Manual Feed mode:

1 Turn the printer off. 

2 Double-click the  icon at right bottom of the window.

3 Select a job you want to cancel. 

4 For Windows 9x/Me, select Cancel Printing from 
Document menu. 
For Windows NT/2000/XP, select Cancel from Document 
menu. 

5 When the jobs are removed from the list. Turn the printer 
on.

Double-click this icon to view 
the queue of the print jobs. 
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Printing on Envelopes

1 Open the rear output tray. Load the envelopes into the 
manual feeder with the flap side down. 

The stamp area is on the left side and the end of the 
envelope with the stamp area enters the feeder first. 

2 Adjust the guide to the edge of the envelope stack. 

Guidelines
• Only use envelopes recommended for laser printers. Before 

loading envelopes in the manual feeder, make sure that they 
are undamaged and are not stuck together. 

• Do not feed stamped envelopes.
• Never use envelopes with clasps, snaps, windows, coated 

lining, or self-stick adhesives. These envelopes may severely 
damage the printer.
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3 When you print on envelopes, you must select Manual 
Feed for Source from the software application, and then 
select the correct paper size and type. For details, see 
page 4.6. 

4 Press the Cancel button to start feeding. 

Notes: Please be careful when you open the rear cover. The inside 
of the printer is still hot.

5 Printing is started. Close the rear output tray.
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Printing on Labels

1 Open the rear output tray. Load labels in the manual feeder 
with print side up. 

2 Adjust the guide to fit the width of the labels.

Guidelines
• Only use labels recommended for laser printers.
• Verify that the labels’ adhesive material can tolerate fusing 

temperature of 200°C (392°F) for 0.1 second.
• Make sure that there is no exposed adhesive material 

between the labels. Exposed areas can cause labels to peel 
off during printing, which can cause paper jams. Exposed 
adhesive can also cause damage to printer components.

• Do not feed a sheet of label through the printer more than 
once. The adhesive backing is designed for one pass through 
the printer.

• Do not use labels that are separating from the backing sheet 
or are wrinkled, bubbled, or otherwise damaged.
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3 When you print on labels, you must select Manual Feed for 
Source from the software application, and then select the 
correct paper size and type. For details, see page 4.6. 

Notes: Please be careful when you open the rear cover. The inside 
of the printer is still hot.

4 Press the Cancel button to start feeding. Printing is started. 
Close the rear output tray.

Note: To prevent labels from sticking, do not let the printed label 
sheets stack up as they are printed out. 

Printing on Transparencies

1 Open the rear output tray. Load transparencies in the 
manual feeder with print side up, and the top with the 
adhesive strip going first. 

Guidelines
• Only use transparencies recommended for use in laser 

printers.
• Ensure that transparencies are not wrinkled, curled, or have 

any torn edges.
• Hold the transparencies by the edges and avoid touching the 

print side. Oils deposited on the transparency can cause print 
quality problems.

• Be careful not to scratch or leave fingerprints on the print 
side.
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2 Adjust the guide to fit the width of the transparencies.

3 When you print on transparencies, you must select Manual 
Feed for Source from the software application, and then 
select the correct paper size and type. For details, see 
page 4.6. 

Notes: Please be careful when you open the rear cover. The inside 
of the printer is still hot.

4 Press the Cancel button to start feeding.
Printing is started. Close the rear output tray. 

Notes: 

• To prevent transparencies from sticking, do not let the printed 
sheets stack up as they are printed out.

• Place transparencies on a flat surface after removing them from 
the printer.
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Printing on Card Stock or 
Custom-sized Materials

Postcards, 3.5 by 5.83 in.(index) cards and other custom-sized 
materials can be printed with this printer. The minimum size is 
76 by 127mm(3.0 by 5.0 in.) and the maximum size is 216 by 
356mm(8.5 by 14 in.).

1 Open the rear output tray. Load print material with print 
side up, short edge first and against the left edge of the 
feeder. 

2 Adjust the guide to fit the width of the material.

Guidelines
• Always insert the short-edge into the Manual Feeder first. If 

you want to print in landscape mode, make this selection 
through your software. Inserting paper long-edge first may 
cause a paper jam.

• Do not print on media smaller than 76mm (3.0 in.) wide or 
127mm(5.0 in.) long.
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3 When you print on card stocks or the custom-sized paper, 
you must select Manual Feed for Source from the 
software application, and then select the correct paper size 
and type. For details, see page 4.6.

Note: If the size of your print material is not listed in the Size box 
in the Paper tab of the printer driver properties, click Add 
Custom button and set the size manually. See page 4.6. 

4 Press the Cancel button to start feeding. 
Printing is started. Close the rear output tray.
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This chapter explains the printing options and common 
printing tasks. 

This chapter includes:

• Printing a Document

• Setting Paper Properties

• Using the Toner Save Mode

• Printing Multiple Pages on One Sheet of Paper
(N-Up Printing)

• Scaling Your Document

• Fitting Your Document to a Selected Paper Size

• Printing Posters

• Setting Graphic Properties

• Printing Watermarks

• Printing Overlays

• Using the Status Monitor

• Setting Up Locally Shared Printer

Printing Tasks
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Printing a Document

The following procedure describes the general steps required for 
printing from various Windows applications. The exact steps for 
printing a document may vary depending on the application 
program you are using. Refer to the User’s Guide of your 
software application for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed (It may look slightly different depending on your 
application). 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 To take advantage of the printer features provided by your 
printer, click Properties in the application’s print window 
and go to step 4. 

If you see Setup, Printer, or Options, click that button 
instead. Then click Properties in the next screen.

Make sure that your 
printer is selected.
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4 Now you see the Samsung ML-2150 Series Properties 
window, which allows you to access all the information you 
will need when using your printer. 

The Layout tab is first displayed.   

If necessary, select the Orientation option. 

The Orientation option allows you to select the direction in 
which information is printed on a page. 
•Portrait prints across the width of the page, letter style. 
•Landscape prints across the length of the page, spreadsheet 
style. 

•If you want to rotate the page in 180 degrees, select Rotate 
180 Degrees.

5 From the Paper tab, select the paper source, size and type. 
For further details, see page 4.6. 

6 Click other tabs on the top of the Samsung ML-2150 Series 
Properties window to access other features, if needed. 

The preview image 
shows the sample page 
with the settings you 
currently specified.

� Landscape � Portrait
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7 When you complete setting the properties, click OK until 
the Print window is displayed. 

8 Click OK to start printing. 

Notes:

• Most Windows applications will override settings you specify in 
the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. Follows this 
procedure.

1 Click the Windows Start button.

2 For Windows 9x/Me/2000/NT, select Settings, and then 
Printers. 
For Windows XP, select Printers and Faxes.

3 Select the Samsung ML-2150 Series printer.

4 Click the right mouse button on the printer icon and:
• In Windows 9x/Me, select Properties.
• In Windows 2000/XP, select Printing Preferences.
• In Windows NT, select Document Defaults.

5 Change the settings on each tab, and click OK.

Canceling a Print Job

There are two ways to cancel a print job.

To stop a print job from the Control Panel

Press the Cancel button on the control panel. 
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The printer will finish printing the page that is moving through 
the printer and delete the rest of the print job. Pressing Cancel 
cancels only the current job in the printer. If more than one print 
job is in the printer memory, Cancel must be pressed once for 
each job.

To stop a print job from the Printers folder

1 From the windows Start menu, select Settings.

2 Select Printers to open the Printers window, and double-
click the Samsung ML-2150 Series icon. 

3 From the Document menu, select Cancel Printing 
(Windows 9x/Me) or Cancel (Windows NT 4.0/2000/XP).

Using a Favorite Setting

The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

To use a saved setting, just select the item from the Favorites 
drop down list. 

To delete a favorite setting item, select the desired item from 
the list and click Delete. 

You can also restore the printer driver’s default settings by 
selecting Defaults from the list. 

Using Help

This printer has a help screen that can be activated by the Help 
button in the printer’s properties window. These help screen 
give detailed information about the printer features provided by 
the printer driver.

You can also click  from the upper right hand corner, and then 
click on any setting. 
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Setting Paper Properties

Use the following options to set the basic paper handling needs 
when you access the printer properties. See page 4.2 for more 
information on accessing printer properties. 

Click the Paper tab to access various paper properties. 

Property Description

Copies allows you to choose the number of 
copies to be printed. You can enter up to 
999. 

Size option allows you to choose the size of 
paper you loaded into the tray. 

If the required size is not listed in the Size 
box, click Add Custom. When the Custom 
Page Size window appears, set the paper 
and click OK. The size setting appears in the 
size list so that you can select it. 

➀

➁

➂

➃

➀

➁

Enter the custom 
name you want 
to use. 

Enter the paper 
size. 
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Make sure that Source is set to the 
corresponding paper tray.

Manual Feed source is used when you use 
the Manual Feeder to print using special 
materials. You have to load one sheet at a 
time into the the printer. see page 3.8.

If the paper source is set to Auto Select, 
the printer automatically selects paper 
from the Manual Feeder first and then from 
the Tray.

Make sure the Type is set to Printer 
Default. If you load a different type of 
print materials, select the corresponding 
paper type. For further information on print 
materials, refer to chapter 3 "Using Print 
Materials".

Property Description

➂

➃
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Using the Toner Save Mode

Toner Save mode allows the printer to use less toner on each 
page. Selecting this option will extend the life of your toner 
cartridge and reduce your cost per page, but will reduce print 
quality. 

There are two ways to enable the Toner Save mode:

From the Control Panel

Press the Cancel button on the control panel. The printer must 
be in Ready mode (On Line/Error green LED is on).

• If the Toner Save LED is on, the mode is enabled and the 
printer uses less toner to print a page.

• If the Toner Save LED is off, the mode is disabled and the 
printer prints in the normal mode.
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From the software application

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2.

2 Click the Graphics tab, and select the Toner Save option. 
You can select from: 

•Printer Setting: If you select this option, this feature is 
determined by the setting you’ve made on the control 
panel of the printer.

•On: Select this option to allow the printer to use less toner 
on each page.

•Off: If you don’t need to save toner to print a document, 
select this option. 

3 Click OK.
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Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of 
paper. To print more than one page per sheet, the pages will 
appear decreased in size and arranged on the sheet. You can 
print up to 16 pages on one sheet.

1 To change the print settings from your software application, 
access the printer properties. See page 4.2.

2 From the Layout tab, and choose Multiple Pages per 
Side in the Type drop-down list. 

3 Select the number of pages you want to print per sheet (1, 
2, 4, 9 or 16) in the Pages per Side drop-down list.

Check Print Page Border to print a border around each 
page on the sheet. Print Page Border is enabled only if 
the Pages per Side is 2, 4, 9, or 16.
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4 Select the page order, if necessary.

5 Click the Paper tab, select the paper source, size and type.

6 Click OK and print the document. 

Right then 
Down

1

3

2

4

1

2

3

4

2

4

1

3

3

4

1

2
Down then 
Right

Left then 
Down

Down then 
Left
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Scaling Your Document

You can scale your print job on a page. 

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2. 

2 From the Layout tab, and select Reduce/Enlarge in the 
Type drop-down list. 

3 Enter the desired scaling rate in the Persentage input box. 

You can also click the ��or ❷ button.

4 Click the Paper tab, select the paper source, size and type. 

5 Click OK and print the document. 
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Fitting Your Document to a Selected 
Paper Size

This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2.

2 From the Layout tab, and select Fit to Page in the Type 
drop-down list. 

3 Select the correct size from the Target Paper drop-down 
list.

4 Click the Paper tab, select the paper source, size and type.

5 Click OK and print the document.

A
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Printing Posters

This feature allows you to print a single-page document onto 4, 
9, or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2.

2 Click the Layout tab, and select Poster in the Type drop-
down list. 

3 Configure the poster option:

You can select the page layout from 2x2, 3x3, or 4x4. If you 
select 2x2, the output will be automatically stretched to 
cover 4 physical pages. 
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Specify an overlap in millimeter or inch to make it easier to 
reconstruct the resulting poster. 

4 Click the Paper tab, select the paper source, size and type.

5 Click OK and print the document. You can complete the 
poster by reconstructing the results. 



PRINTING TASKS4.16

Setting Graphic Properties

Use the following Graphic options to adjust the print quality for 
your specific printing needs. See page 4.2 for more information 
on accessing printer properties. 

Click the Graphics tab to display the properties shown below. 

Property Description

Resolution

You can select the printing resolution by 
choosing from 1200 dpi Class (Best), 600 
dpi (Normal) or 300 dpi (Draft). The 
higher the setting, the sharper the clarity of 
printed characters and graphics. Higher 
settings may increase time it takes to print a 
document. 

Toner Save

Selecting this option will extend the life of 
your toner cartridge and reduce your cost per 
page without a significant reduction in print 
quality. For detailed information about this 
mode, see page 4.8.

➀

➁

➂

➃

➀

➁
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Image 
Mode

Some printed characters or images appear to 
have jagged or uneven edges. Set this Image 
Mode option to improve the print quality of 
your text and image, and make the characters 
and images appear smoother. 
The Image Mode option is only available when 
you select 1200 dip Class (Best) in the 
Resolution option.
• Text Enhance: This setting refines the print 

quality of characters by smoothing out 
jagged edges that can occur on the angles 
and curves of each character. 

• Image Enhance: This setting refines the 
print quality of photo images. 

Advanced 
Options

You can set advanced settings by clicking the 
Advanced Options button. 

Darkness

Use this option to lighten or darken the image 
appearance in your print.
• Normal: This setting is for normal 

documents.
• Light: This setting is for bolder line widths or 

darker gray-scale images.
• Dark: This setting is for finer line width, 

higher definition in graphics, and lighter gray-
scale images.

When the Darken Text option is checked, all 
text in your document is allowed to print darker 
than a normal document. 

Property Description

➂

➃
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Advanced 
Options
(continued)

True-Type Options
This option determines what the driver tells the 
printer about how to image the text in your 
document. Select the appropriate setting 
according to the status of your document. 
• Download as Bit Image: When this option 

is selected, the driver will download the font 
data as bitmap images. Documents with 
complicated fonts, such as Korean or Chinese, 
or various types of fonts will print faster in 
this setting. 

• Print as Graphics: When this option is 
selected, the driver will download any fonts as 
graphics. When printing documents with high 
graphic content and relatively few TrueType 
fonts, printing performance (speed) may be 
enhanced in this setting. 

When the Print All Text Black is checked, all 
text in your document is allowed to print solid 
black, regardless of the color it appears on the 
screen. When it is not checked, colored text is 
allowed to print in shades of gray.

Property Description

➃
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Printing Watermarks

The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across 
the first page or all pages of a document. 

There are several predefined watermarks that come with the 
printer, and they can be modified or you can add new ones to 
the list. 

Using an existing Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2. 

2 Click the Extras tab, and select the desired watermark in 
the Watermark drop-down list. You will see the selected 
watermark in the preview image. 

3 Click OK to start printing. 
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Creating a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 4.2. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Watermarks window appears. 

3 You can enter the desired text message in the Watermark 
Message box. 

This will be displayed in the preview window. The preview 
image is provided so that you can see how the watermark 
will appear on the printed page. 

If the First Page Only box is checked, the watermark will be 
printed on the first page only.

4 Select the desired watermark options. 

You can select the font type and size, and color from the 
Font Attributes section, and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you complete editing, click OK and start printing. 

To stop printing the watermark, select <No Watermark> in the 
Watermark drop-down list. 




